Export Cuelist for gma3

“(OF) COURSE

This is simple tool to Export Cue List (Sequence) to the grandMA3.
Change Cue Number (renumber), Cue Fade or Info from within the application. You can also print your Cue List (Sequence).

You can export cue list from midi file. Midi file you can prepare in almost all music application like Pro Tools, Logic Pro, Cubase, Reaper etc.

In this help we show you how export cue list from Reaper.
Just import to Reaper multimedia file (music or video) you’re working on.
Prepare all Cues (Markers in Reaper) — light changes, accents, solos, etc. that you want to use in show.

Export Cuelist for gma3 will finish all work for you by importing to console Of Course:
— Cue List (Sequence)

—Sequence number

—Sequence name

— Page number

—Page name

— Executor number

— Cue Time — for Trigger Time

— Cue Fade

As simple as that!
Don’t miss that chance! Do not hesitate and try it completely for free!

Description:

Download and install "Reaper":
http://www.reaper.fm/download.php

Download and install "SWS Extension" for Reaper:
http://www.sws-extension.org/

1. Run Reaper.
2. Open View tab and set Time unit for ruler to Seconds.

@ REAPER File Edit View Insert Item Track Options Actions Extensions Window Help [44.1kHz 24bit WAV : 0/2ch 512spls ~11/20ms] 100% @3 Sob. 4.01 01:11:03 jolo Q @ =

Mixer #M ~ ID Description

Master Track XM
Floating Mixer Master

v Transport R8T
v Video 08V

Monitoring FX

Docker
Toolbar Docker

Media Explorer

Routing Matrix

Grouping Matrix

Track Wiring

Project Media/FX Bay #B

Track Manager 0 ¥8M

Screensets/Layouts ®E
v Region/Marker Manager

FX Browser OF

Media Item Properties (]

v Big Clock XC
Performance Meter %8P
Peaks Display Settings

Navigator X8V
Tempo Envelope XT
Scale Finder Regions.
Virtual MIDI Keyboard XB v Markers

a - o o #~ Name Start End Length
Show/hide all floating windows X $F

Cascade all floating windows

Time unit for ruler > Minutes:Seconds
Measures.Beats

Zoom > Measures.Beats (minimal)

Goto > |V Seconds
Samples

RFN Hours:Minutes:Seconds:Frames
Absolute Frames
Secondary time unit [ 2

Always on top
Fullscreen

Filter: Clear

L ]




3. Open Insert tab and insert new Track.

OfCourse_ExportTT [modified] - REAPER v6.02/64 - Registered to Grzegorz Barszczewski (Licensed for personal/small business use)

ID Description

Insert new track

Insert new track at end of track list
Insert virtual instrument on new track...
Insert track from template

Save tracks as track template...

Remove tracks

Duplicate tracks

Move tracks to new subproject
Render/freeze tracks

MIDI track controls

Lock track controls

Lock track height

Free item positioning

Automatic record-arm when track selected
v Multichannel track metering

Track Manager (show/hide tracks)... 0 ¥M
Track color
Track icon

Track timebase Regions.
Track automation mode v Markers
Track performance options End  Length
Track layout

Envelopes

Track grouping parameters...
v Track grouping enabled

SWS Snapshots

Filter:

4. Open Insert tab and Import your media file.

& REAPER File Edit View Insert Item Track Options Actions Extensions Window Help [44.1kHz 24bit WAV : 0/2ch 512spls ~11/20ms]  100% @3 Sob. 4.01 00:39:17 jolo Q @ :

Media file... @ ID Description
New MIDI item

Empty item

SMPTE LTC/MTC Timecode Generator
Click source

gouto [FX New subproject

Marker
Marker (prompt for name)

goute || e [

Tempo/time signature change marker

Track

Multiple tracks...

Virtual instrument on new track...
Track from template

Regions
v Markers

End  Length

Filter:




5. Create a Cue List (Sequence) use the Markers and give the names for Cues. Important: don’t use comma (“,”) in cue name.
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ID Description
1 pre show
2 start

Add Marker

Name: [1i]

Position:  6.261

Set color... Reset color Cancel

Regions
v Markers

#~ Name End Length

M1 pre show
M2 start

6. Open Extension tab and open Marker List, click right mouse button and use the tab Convert markers to regions.

®  ® Marker List

ID Description

pre show

verse
chorus
frase

owm\:o’manm

solo

Rename

Set color...

Save marker set...
Delete market set...

| Copy marker set to clipboard

~ Paste marker set from clipboard

# i
N Reorder marker IDs

M1 Pl Reorder region IDs

M2 st

M3 hi Delete selected marker(s)
M4 hi Delete all markers

M5 hi Delete all regions

M6 hi

V5 Export formatted marker list to clipboard
Vi

e Export formatted marker list to file
5 Export forma

Convert markers to regions

Convert regions to markers

OOOOOO0O0O00

Dock Marker List in Docker
Close window




7. Save Reaper Project.
8. Open View tab and open Region/Marker Manager.
9. Click right mouse button and use the tab Export region/markers, name the text file (*.csv) and save it.

1 preshow i i 8 chorus ? n
Time ID Description
0.000 1 pre show
4174 2 start
6.261 3 hit
L 8.348 4 hit
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AP < N O et D P O R DO b st vt [N
ool it ST oot , Aot S SO 1 4 oD Tt e e SO e OO . & e o S v ot oAl | o e a
Region/Marker Manager
[| 2 Regions
Markers
#~ Name Start End Length
D R1 pre show 0.000 4174 4174
e 4174 6.261 2.087
cers/|
Cted mar KO 1 6.261 8348 2087
Renumber in timeline order (markers, then regions) 8348  10.435 2087
Import regions/markers (replace existing)... 10.435 12.622 2.087
Import regions/markers (merge with existing)... 12622|  14.609 2.087
Export regions/markers, 14609  22.957 8.348
s 22957 27130 4174
v Show track render menu nested by folders 27130  31.304 4174
|
‘ F 3 31.304 34.204 2.900
v Seek playback when selecting a marker or region
Play region through then repeat or stop when selecting a region
Dock Region Manager in Docker
Close window Filter: Clear
bL n

Your Cue List (Sequence) is ready and now. You can export it to the grandMA3 use Export Cuelist for gma3.

Run Export Cuelist for gma3.

Click tab Settings.

1. Set directories for Macro — grandMA3 OnPC Macro Folder or USB Memory Stick Macro Folder, default is: [Disk]\grandMA3\shared\resource\lib_macros\
2. You can also set default Trigger, Fade.

3. Save settings.

Page number
1
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Cue name Trigger
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Export TimeCode2 Sequence number

for gma2 2
Sequence label
CueList

Page label

3/ Page
Export Cuelist? for Export CueList for gma3 / Settings

gma:

Settings

Directories to export fles: (defaut [Disk]\grandMA3\shared \resource\ib_macros)

folder Macro
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Register to:
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Load file
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4. Click tab Load file and select your Cue List (Sequence).

Directly from Reaper Project.

Export TimeCode2
for gma2

Export CueList2 for
gma2

dmx2percent

)

ownCloud

Organizuj ~

Trigger

& Otwieranie
¢« > v 4 B> ownCloud > ExportC&TT > TC&TT.2020 > Tigma3 > Reaper_ > Projects

Nowy folder

B Obrazy OfCourse_ExportTT_regions.csv song.mid
Plik CSV Sekwencja MIDI

B Exportic2

3038 20,4K8
B ExportT2
B Release

B Release
. ownCloud
@ OneDrive - igloo.pl

Ten komputer
B Dokumenty
D Muzyka
WP Obiekty 3D
Obrazy
4 Pobrane
M Pulpit

[project or music fles (*.csv, 7 v

Nazwa pliku: | OfCourse_ExportTT.RPP

Or, from exported text file from Reaper Project (*.csv).

Export TimeCode2
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dmx2percent

ownCloud

Trigger
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B ExportT2
B Release
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Or from midi file,

D

Export TimeCode2
for gma2

Export CueList2 for
gma

dmx2percent

ownCloud

Cue name Trigger

& Otwieranie

€ > v 4 B> ownCloud > ExportTC&TT > TCKTT.2020 > TI.gma3 > Reaper_ >

Organizsj v Nowy folder

B Obrazy OfCourse_Export TTRPP
B ExportT REAPER Project File
480KB
B ExportTR2
B Release
B Release
. ownCloud

@ OneDrive - igloo.pl
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B Dokumenty
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OfCourse_ExportTT_regions.csv.
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Page number
1

Executor number
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2
Sequence label
Cuelist
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Page

Typ: Sekwencja MIDI
Rozmiar: 20,4 KB
Data modyfikacji: 25.05.2020 14:54

Load file

Settings

Help

As a result, you will see your Cue List (Sequence).

D

Export TimeCode2
for gma2

Export CueList2 for
gma

dmx2percent

¢@®),

ownCloud

™ Export Cuelist for gma3

OF COURSE Apps
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Generate files

Print CueList
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Help
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Now you can change the Name, Number, Fade for cues.

™ Export CueList for gma3

Cue name
pre show

D

Export TimeCode2
for gma2

Export CueList2 for
gma2

l

dmx2percent

[ J N

ownCloud

Trigger

change fade time
change trigger
change name

remove cue

e

5. Do not forget to set Page number, Executor number, Sequence number, Sequence label, Page label.

™ Export CueList for gma3

Page number
1

Executor number
201

Sequence number
2

Sequence label
CueList

Page label

Page

Load file

Generate files

Print CueList
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Settings
Help
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Export_TT|
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You can also print Cue List (Sequence).

D

Export TimeCode2
for gma2

Export CueList2 for
gma2

dmx2percent
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video tutorial

And renumber the cue.
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Finally, you have two ways how to export Cue List (Sequence) to grandMA3.
Export by Macro:
Run Export Cuelist for gma3.

Click tab Settings.
1. Set directories for Macro — grandMA3 OnPC Macro Folder or USB Memory Stick Macro Folder, default is: [Disk]\grandMA3\shared\resource\lib_macros\

Page ber
Cue name Trigger S8 D

1
Executor number

Time

Export TimeCode2 t Time . Przegladanie w poszukiwaniu folderu
port TimeCode2

for gma2 s [

Time

Time

verse grandMA3
— config

Export CuelList2 for 8 chorus |
gma2 export

frase
onpc

Settings shared

backups

solo

Directories to export files: (defaut [Disk]\grandMA3\shared vesourceib_macros) demoshows

lib_fixture_types

Tigger resource

fistcue [Go fonts
defaut [ Time v keyboards

lib_appearance
fade time [2.00 _2pp!

dmx2percent lib_color_themes
Registerinfo lib_gels
Application ID: lib_images
Registerto lib_keyboard_shortcuts
Version: 1.0.0.1 (Ful) lib_layout
lib_macros
ownCloud how info at StartUp to_ matricks
lib_media
lib_mvr
lib_plugins
lib_presets
lib_stage
s

Utwérz nowy folder Anulj
Settings

Help

video tutorial ) OF COURSE Apps

2. Click Generate files, choose what you want: marge or create sequence.

Page number
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Sequence number
for gma2 2

2
Sequence label
Eot_TT
verse Page label
Export CueList2 for 8 chorus - Expot_TT
gma2

frase

solo

Export CueList for gma3 - Alert

Do you want to merge cue in all sequence?
(marge don'timport color and fade values)

Nie Anuluj

ownCloud

Load fie

Generate files

Print CueList
Renumber

Settings

Help
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Your Cue List (Sequence) with selected Page, Executor, Trigger, Fade is ready to be imported using a Macro from folder in grandMA3 OnPC or from macro folder on USB Memory Stick!

Page number

1

Executor number
P

Export TimeCode2
for gma2

Export CueList2 for
gma

Cuelist for gma3 - Alert

dmx2percent

ownCloud

Print CueList
Renumber
Settings
Help
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4. Run your show on grandMA3.

2 [cuelist] Display 1

Fixture

Macros

Preset

Sequence
Sheet

Tracking
Sheet

= p

ShCut

Grand
MAtricks Master

100.0%

| E=E  Admin[Fixture]>

Absolute Relative Fade Delay Speed Phase Repeat  Accel Decel  Transitio Width « =»

Feature

Percent




5. Create Macro, and choose Import.

onPC 1.1.4.2 [cuelist] Display 1

Lock No Name Command

Wait Enabled AddToCmdl Execute

New MacroLine

Insert New MacroLine

Oops
| E=  Admin@ShowData/DataPools/Default/Macros/Macro 1>
Sync

Single

Absolute Relative Fade Delay
Step

Feature
Off

Percent

6. Choose drive, and select M.xml file.

Macro 1

Speed Phase Repeat  Accel Decel

onPC 1.1.4.2 [cuelist] Display 1

Selectifilejtolimport{into]Macro}

Filter:

Lock No Name

SL 1 CueList.xml

M.xml

MAKUSUSB |.

‘ Clear

FileName FileSize

CueList.xml 163B 15

M.xml 2.8kB 15

Transitio Width

MAtricks

-

ScreenY
Display 1
Screen X
Display 1

GO

List
References

S
nout

Grand
Master

100.0%

-




7. Now run this Macro.

Lock No Name

MacroLine 1
MacroLine 2
MacroLine 3
MacroLine 4
MacroLine 5
MacroLine 6
MacroLine 7

MacroLine 8

O 0O N O O A~ W N

MacroLine 9

o

MacroLine 10

Insert New MacroLine

onPC 1.1.4.2 [cuelist] Display 1

Command Wait Enabled AddToCmdl

Delete Sequence 2 /nc
Store Sequence 2 Cue 1 "pre show" CueFade="2.00"
Store Sequence 2 Cue 2 "start" CueFade="2.00"
Store Sequence 2 Cue 3 "hit" CueFade="2.00"
Set Sequence 2 Cue 3 TrigType=Time
Set Sequence 2 Cue 3 TrigTime="2.087"
Store Sequence 2 Cue 4 "hit" CueFade="2.00"
Set Sequence 2 Cue 4 TrigType=Time
Set Sequence 2 Cue 4 TrigTime="2.087"
Store Sequence 2 Cue 5 "hit" CueFade="2.00"

Execute

(¢]¢]

Import Macro 1'Export_TT'
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Oops Export References

E=  Admin@ShowData/DataPools/Default/Macros/Macro 1> >
"

. Grand
MAtricks Master
100.0%
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Screen'Y

' Display 1

. Screen X

Percent Display 1

Your Cue List (Sequence) with selected Page, Executor, Trigger, Fade is already in show on grandMA3!

onPC 1.1.4.2 [cuelist] Display 1

Export_TT Fixture
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o o onPC 1.1.4.2 [cuelist] Display 1

EditiSequence 2{ExportSTTH
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Single Edit
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- CuelnFade 2 CuelnDelay 2 SnapDelay
off ‘ . ’ 0 \ . J

CueOutFade
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